
PVII Pop Menu Magic 3 

The state of the art in Dreamweaver menu systems... 

 
Create gorgeous and responsive multi-level menus in Dreamweaver with just a few clicks! 

We hope you enjoy using this product as much as we did making it. 

Al Sparber & Gerry Jacobsen PVII 
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Install the extension 
Extension installer files come in 2 formats: MXP and ZXP. MXPs are supported by Extension Manager 
versions MX, MX2004, 8, CS3, CS4, CS5, CS5.5 and CS6. ZXP is supported by versions CS5.5 and higher. 
Version CC and higher have dropped support for the MXP format. To continue to support all Adobe 
customers, regardless of version, we include both the classic MXP and the new ZXP versions. 

For version CS6 and older: 

Look for the extension installer file p7_PMM3_348.mxp or p7_PMM3_348_upg.mxp in the root of the 
zip archive you downloaded. Double-click the files to install the extensions. Dreamweaver's Extension 
Manager will open and you will be prompted to complete the installation. 

For version CC and higher: 

Look for the extension installer file p7_PMM3_348.zxp or p7_PMM3_348_upg.zxp in the root of the zip 
archive you downloaded. Double-click the files to install the extensions. Dreamweaver's Extension 
Manager will open and you will be prompted to complete the installation. 

About the ZXP Extension Installer Format  

The ZXP format is identical to the tried and true MXP format developed by Macromedia with the chief 
difference being the file extension. It was adopted by Adobe to support its efforts to move third party 
extensions to the Adobe Exchange Store (for a fee)—a service we have no need for at this time. 

When you install the ZXP version of Pop Menu Magic 3, you might see this alert box, which is totally 
harmless, despite its looks. 

 

Simply click the Install button and your extension will be installed without issue.  

The purpose of a digital signature is primarily to protect the software developer's interest, ensuring that 
no one has altered the file from its original state. When you buy directly from the developer, in this case 
PVII, this is not an issue. Adobe's process to create a digital signature file requires installing third-party 
software that fails to meet our quality standards at this time. Even if we were able to use Adobe's 
software, the signature is only activated by going through Adobe's Exchange and sharing revenue with 
Adobe—which we have no need to do. 
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Work in a defined Dreamweaver site  
Before you begin, make sure you are working inside a defined Dreamweaver web site. This is necessary 
so that Dreamweaver knows how to link required assets. If you are new to Dreamweaver or need to 
learn how to define a web site, follow these simple steps: 

Choose Site > New Site 

Specify local site location  
The Site category of the Site Setup dialog box is the only one you need to fill out to begin working on 
your Dreamweaver site. This category lets you specify the local folder where you’ll store all of your site 
files. When you’re ready, you can fill out the other categories in the Site Setup dialog box, including the 
Servers category, where you can specify a remote folder on your remote server.  

Site Name  

The name that appears in the Files panel and in the Manage Sites dialog box; it does not appear in the 
browser.  

Local Site Folder  

This is the name of the folder on your local disk where you store site files, templates, and library items. 
Create a folder on your hard disk or click the folder icon to browse to the folder. When Dreamweaver 
resolves site root-relative links, it does so relative to this folder. 

Overview 
Pop Menu Magic 3 automates the process of building multi-level collapsible CSS-based menus. You can 
add as many menus to the same page as you like. Each Pop Menu can be styled independently or you 
can have some, or even all, share the same style. The options for each Pop Menu are set 
independently—each with its own dedicated user interface. 

The Pop Menu Magic 3 user interface is designed to automatically open to the correct mode based on 
your current insertion point in the document. 

Responsive and Mobile Ready 
The Pop Menu Magic 3 is designed to automatically respond to the size of the browser window and the 
device being used. 
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Touch Device and Smart Phone Support 
The Pop Menu Magic 3 system is designed to work perfectly on all touch enabled devices—including 
iPhone, iPad, Android, other smartphones and tablets. On smartphones, a toggle bar will appear above 
the menu with an icon that users can tap to hide or show the entire menu. The toggle bar uses an 
industry-standard 3-bar icon. You can optionally include Show Menu/Hide Menu text next to the icon. 

 

  



 

PVII Pop Menu Magic 3 
 

7 Overview 

7 

Auto-Convert Existing PMM1, PMM2, DMM, jQuery, Spry, or any 

list-based menu 
PMM3 can optionally convert any existing list-based menus. Place your cursor inside an existing PMM1, 
PMM2, DMM or other list-based menu and open the PMM3 interface. A converter dialog will open. 
Follow the onscreen instructions to complete your update or to cancel the operation. 

 

  



 

PVII Pop Menu Magic 3 
 

8 Overview 

8 

Automated Bread Crumb Builder 
PMM3 includes an integrated Breadcrumb Builder that provides the ability to generate a Breadcrumb 
trail on any page that is using a Pop Menu Magic 3 navigation system. The Breadcrumb trail can be 
placed anywhere on your page and can be easily modified at any time.  

 

To access the Breadcrumb Builder, place your cursor on the page where you want the Breadcrumb Trail 
to go. There must be at least one PMM3 menu on the page.  Make sure that your insertion point is not 
inside a PMM3 menu. It can be anywhere on the page – except inside a menu. Open the Breadcrumb UI 
by choosing: 

Commands > Studio VII > Pop Menu Magic 3 by PVII > Breadcrumb Trail Builder 

The interface will open. Click the Help button in the UI to review how the system works and what the 
various options do. 
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Create or Modify 
The user interface has 2 modes, Create and Modify, and will automatically open in the correct one 
based on your current insertion point in the document: 

 If your insertion point is not within an existing PMM3 menu, the interface will open in 

Create mode.  

 If your insertion point is inside an existing PMM3 menu, the interface will open in Modify 

mode.  

Configurable Menu Titles 
Optionally set any item in your menu to display as a title rather than a link. Titles can be used to divide a 
sub-menu into different sections or to include a marketing message. 

Configurable Edge Detection 
PMM3 includes optional auto edge detection to keep sub-menus inside the visible window or menu 
container element. Edge detection can be set to Window Edge, Menu Width, or None. 

Automatic Sub-Menu Width 
Sub-menu width can be set to fixed or auto (default). The width of a sub-menu, when using the auto 
width option, is determined by the longest link within that sub-menu. With auto width enabled, links will 
not wrap to multiple lines. 

Configurable Sub-Menu Positioning 
Sub-menus can be positioned to open to the right (default), left, or upward. In a horizontal menu, the 
left option applies to the third and subsequent levels only. 

Dreamweaver Template Support 
The system is specifically designed to support Dreamweaver templates. You can insert one or more 
menus into a template (.dwt) master page at any time. You can also insert one or more menus into a 
template-based child page. The system will automatically detect the template and adjust to allow 
insertion into an editable region. 
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Current Link Marking and Auto Sub-Menu Opening 
The system includes an optional feature that looks for links in the menu that match the current page 
address. When a match is found, the link is highlighted. The system assigns a special style class named 
current_ mark to the matching link and its parent root item (if applicable). Current Marking can be 
turned on or off for each menu on your page. 

Pop Menu Magic 3 also includes an Advanced Current Marker system that allows you to handle 
exceptions—so that even pages that do not appear as links in the menu can be highlighted. 

Advanced Current Marking 

Pop Menu Magic 3 also includes an Advanced Current Marker system that allows you to handle 
exceptions—so that even pages that do not appear as links in the menu can be highlighted. To access it, 
on a page that contains a PMM3 menu, choose Commands > Studio VII > Pop Menu Magic 3 > Advanced 
Current Marker Options.  

The Advanced Current Marker user interface will open.  

 

Click the Help button to access the ACM help files. 
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Image Support 

The system supports using images for the menu items and automatically handles pre-loading, swapping, 
multiple state management and current marking. This automation requires that you follow the image 
file name convention. The system supports up to 3 different image states. If your default image is 
named home.jpg, then you would name your over image home_over.jpg and your open/current-mark 
image home_down.jpg. All images must be in the same folder. In the PMM3 interface, you only need to 
assign the default image (home.jpg). The PMM3 script will automatically find the other images. 

First and Last Menu Link Styling 

The system automatically assigns a special CSS class to the first and last links in the menu in order to 
facilitate styling that requires exception rules for these links. The pm3first class is assigned to the first 
link (and also to its <li> parent tag) in the menu and the pm3last class is assigned to the last link (and its 
<li> parent tag) in the menu. 

Note: The PMM 3 system assigns these special classes dynamically. They are not available in Dreamweaver 
Design View. To see these classes, you will need to preview the page in a browser that supports viewing 
rendered/generated source code. 
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Automated Removal 

A handy Remove command is included that can be used to quickly and thoroughly remove any Pop 
Menu Magic 3 menu from your page. To access the Remove UI, choose: 

Commands > Studio VII > Pop Menu Magic 3 > Remove Pop Menu Magic 3 

 

The interface will provide a listing of all of the Pop Menu Magic 3 menus on your page. The list will 
display the ID of each menu. From the listing, select the menu that you wish to remove. You can remove 
one menu at a time. 

Tip: If you are unsure about which menu relates to which ID, click the Cancel button and switch to Code View. In 
Code View, locate all IDs that begin with P7TM3. The opening DIV tag for a Pop Menu Magic 3 menu looks like this: 
<div id="P7TM3_1" class="P7TM3-01"> 

What will be Removed  

The system will completely remove the html markup for the selected menu from your page. If there are 
other Pop Menu Magic 3 menus on the page they will not be affected. The system will also remove the 
link to the relevant CSS file if no other menu on the page is using the same style theme. If there are no 
remaining Pop Menu Magic 3 menus on your page, the system will also remove the link to the Pop 
Menu JavaScript file. 

What will Not be Removed 

The system will not remove the P7tm3 folder, which contains the menu-related assets (images, 
JavaScript file, and CSS files). This ensures that you will not lose any assets you may have modified and 
any other pages that depend on those modified assets will continue to look and behave as expected. 
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Inserting a New Menu  
Pop Menu Magic 3 menus can be inserted anywhere on your page. Once you have established your 

insertion point, click the Pop Menu icon  to open the interface. Alternatively, you can choose Insert > 
Studio VII > Pop Menu Magic 3 by PVII. You can insert the menu into any area of your page. The menu 
width will automatically adapt to its location, even when placed inside flexible DIVs or table cells. You 
can insert as many individual menus as you like on your page. Each menu can be optioned 
independently to set different behaviors and features. Menus on a single page can share the same style 
theme or be set to separate style themes. 

-Establish the insertion point for your new menu by clicking in the area of the page where you would 
like it to be created.  

Note: The interface is sensitive to the insertion point. If your cursor is currently inside an existing Pop Menu 
component the Modify interface will open instead.  

-Click the Pop Menu Magic 3 icon  in the PVII Section of Dreamweaver's Insert Bar or choose Insert > 
Studio VII > Pop Menu Magic 3 by PVII. 

Classic Dreamweaver Insert Bar 

 

Note: Newer versions of Dreamweaver will only able to display icons in shades of gray, rather than in color. If you 
are using the Creative Cloud version of Dreamweaver, this Insert Panel Tutorial might be of interest. 

Dreamweaver Insert Panel 

 

  

http://www.projectseven.com/tutorials/dreamweaver/insert-bar/index.htm
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The Pop Menu Magic 3 user interface will open in the Create New Pop Menu mode.  

 

You can create more than one menu on your page. Add as many as you like. 

Asset Folders 

When you create a menu, the system creates an assets folder named p7pm3 at the same level as the 
page that contains your menu. This folder will contain the PMM3 JavaScript file and the relevant menu 
style sheet(s), as well as an img sub-folder that contains arrow background images used by the CSS.  

 

When you publish your site, make sure you upload the entire p7pm3 folder. 
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Modifying an Existing Pop Menu 
You can modify any of the existing Pop Menu Magic 3 menus on your page at any time. 

-Click inside the menu that you wish to modify. 

-Click the Pop Menu Magic 3 icon  in the PVII Section of Dreamweaver's Insert Bar or choose: 

 Modify > Studio VII > Modify Pop Menu Magic 3 by PVII 

Note: If you use a Macintosh computer, Apple bugs will sometimes cause the Modify menu to be inactive (grayed 
out). If this happens to you, use the icon to launch the interface. You can also launch the interface from the Insert 
menu. The system will open the interface in the appropriate mode whether you use the Insert Menu, Insert 
Panel/Bar or the Modify menu. 

The Pop Menu Magic 3 User Interface will open in the Modify Existing Pop Menu Magic mode. 
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Managing the User Interface Items 

Mode 

Displays the current operational Mode for the user interface: either Create or Modify. When in Modify 
mode, the id of the menu being modified will also be displayed. 

Menu Items 

This box displays the text for each navigation link in the menu—one line for each link. Select (click) the 
line you wish to act on. 

Add Item 

Click the Add Item button to add a new menu link. This new item will be created immediately after the 
selected item, and at the same level as the selected item. The newly created menu item will initially 
appear with the default description: Menu Item, and the URL will simply be a hash (#) placeholder. 
Change these to suit your needs. The Image Path box is always blank by default.  

Add Sub 

Click the Add Sub button to create a new sub-menu for the selected root link item. A new menu item 
will appear directly beneath the selected menu item, indented one level. The newly created menu item 
will initially appear with the default description: Menu Item, and the URL will simply be a hash (#). 
Change these to suit your needs. The Image Path box is always blank by default. 

Delete 

Click the Delete button to remove the selected menu item. If the menu item contains one or more sub-
menu levels the system will completely remove the selected menu item and all of its sub-menu levels. 

Note: The interface requires at least one item to be in the menu list at all times. The system will not allow you to 
delete a menu item if it is the only remaining one. 

Up 

Click the Up button to move the selected menu item up in the Menu Items list. The menu item, and all of 
its sub-menu items, will be moved up one position each time the button is clicked. If the menu section 
before the selected item is in the open state (sub-menu items showing) then the selected menu item 
will be moved to the last position of the open menu section. 

Down 

Click the Down button to move the selected menu item down in the Menu List. The menu item, and all 
of its sub-menu items, will be moved down one position each time the button is clicked. If the menu 
section after the selected item is in the open state (sub-menu items showing) then the selected menu 
item will be moved to the first position of the open menu section. 
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Item Link or Title Text 

The Menu Link Text box will always display the text of the currently selected line in the Menu Items list. 
Enter or edit the text that you wish to display for this menu link. The box cannot be left blank.  

Note: If an image has been assigned, this box will be disabled (grayed out) and contain the file name of the 
assigned image. Removing the Image Path will re-enable the box for text entry. 

Display as Title 

You can optionally set any item in your menu to display as a title rather than a link. Menu items set to 
this option are no longer links. They can be used instead to divide a sub-menu into different sections or 
to include a marketing message.  

Link Path/ Browse...  

Enter the path to the linked page for this menu item or use the Browse button to open the Select File to 
Link dialog box. The system will automatically supply a "#" link placeholder when new menu items are 
created, which you should change to an actual page link before publishing. 

Image Path / Browse... 

Note: The Image Path box is only used if you are using images for your menu items. For text-based menus this box 
should be left empty.  

Enter the path to your image or use the Browse button to open a Select Image Source dialog box. You 
can change the image at any time by selecting the menu item in the Menu Items list and clicking the 
"Browse..." button. Valid image types are limited to the .gif, .jpg, and .png file types. 

The image you select must always be the default state image. The system will automatically handle 
image pre-loading. Images for additional states (over, and down), depending on the Image Swap 
Option you select, must be stored in the same folder as your default image. The system will 
automatically find them.  

Default state image file names can be any valid name. You must, however, follow a naming convention 
for the additional state images. If your default image for a link is home.jpg, your image file names would 
follow this convention: 

 home.jpg 

 home_over.jpg 

 home_down.jpg 

  



 

PVII Pop Menu Magic 3 
 

18 Overview 

18 

Image Alt Text 

Enter a description for the related image in the Alt Text box. If the image is a picture of hats, then Hats 
would be a good choice for the text to use. 

Options 
These settings are applied to the PMM3 menu you are currently editing. Other menus on the same page 
will not be affected and will retain their unique options.  

Menu 

Choose the menu orientation: Horizontal or Vertical. 

Z-Index 

This option allows you to set a specific z-index for the current menu. The z-index specifies the stacking 
order of the menu versus other positioned elements on your page. An element with a higher z-index 
value will always appear in front of an element with a lower one. Set this number to a very large number 
if you want the menu to appear above all other elements on the page. The default value is set to 900. 
When two or more menus exist on the same page, you can set z-index values for each to achieve the 
stacking order you desire. 

Edge Detection 

The PMM3 system includes a configurable edge detection option to keep sub-menus inside the visible 
window or menu container element. You can choose from 3 settings: 

 None: When you don't want any edge detection. 

 Window Edge: Constrains sub-menus inside the horizontal and top edges of your browser 

window. This will assure that sub-menus are always within the browser's visible viewing 

area. 

 Menu Width (applies to horizontal menus only): Constrains sub-menus inside the 

horizontal edges of the root PMM3 menu container and the top edge of the browser 

window. 

Fixed on Scroll 

Enable this option to allow the menu to remain on the screen when the page is scrolled 
downward. The menu will always be visible and the page content will scroll underneath 
it. 

Auto Sub-Menu Width 

Sub-menu width will be based on the longest menu item within that sub-menu. This option is enabled by 
default. Turn it off if you would prefer fixed-width sub-menus. The default value of for fixed-width sub-
menus is 200px and can be changed by editing the menu CSS. 
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Flyout to Left 

By default, sub-menu flyout levels appear on the right side of their corresponding trigger link. Enable 
this option to have the sub-menu flyout levels appear on the left side of their corresponding trigger link. 

Open Sub-Menu Upward 

Ordinarily, sub-menus drop down from their corresponding trigger links. Enable this option if you want 
your sub-menus to open upwards instead. This option is useful, for example, when your menu is at the 
bottom of your page. 

Sub-Menu Offsets 

You can control the position of the sub-menu relative to its corresponding trigger link. In a horizontal 
menu, this option applies to the third and subsequent menu levels. In a vertical menu, it applies to all 
sub-menu levels. 

Top 

This controls the alignment of the sub-menu's top edge with its trigger link's top edge. Enter a value of 
0 (zero) to align both top edges to meet. Enter a negative number, in pixels, to move the sub-menu 
higher than its trigger. Enter a positive number to move the sub-menu lower than its trigger. 

Left 

This controls the alignment of the sub-menu's left edge with its trigger link's right edge. Enter a value of 
0 (zero) to align both edges to meet. Enter a negative number, in pixels, to cause the sub-menu to 
overlap its trigger. Enter a positive number to move the sub-menu away from its trigger link. 
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Responsive 

By default, the menu always adapts to the width of the element in which it is placed. If your site is a 
responsive design, and you select one of the two responsive conversion modes, the responsive 
version of your menu will display on a smartphone—or in a conventional browser window when its 
width is less than 700 pixels. 

No Conversion 

Choose this option if you site is not built with responsive design or you do not wish to have the 
menu converted. 

Vertical Accordion 

Choose this option to display the menu as a collapsible vertical accordion. The menu will display a 
toggle icon above it when viewed on a smartphone—or in a conventional browser window when its 
width is less than 700 pixels. The toggle icon permits users to completely hide the menu so that they 
can view more of the page content. You should disable this option if your site is not a responsive 
design. 

Start With Closed Toolbar State 

Set this option if you want the default state of your menu, when viewed on a smartphone, to be 
closed. Users will be able to control the visibility of the menu by clicking the toggle icon or text links. 

Show Toggle Text 

Enable this option to also show a text label, "Show Menu" or "Hide Menu" next to the toggle icon in 
the toolbar. The actual text content for these labels can be modified in the Smartphone Menu Media 
Query section of the PMM3 style sheet. 

Jump List 

Choose this option to display the menu as a Jump List ( select list ) when viewed on a smartphone—or 
in a conventional browser window when its width is less than 700 pixels. The single line Jump List item 
will always display with the current menu item showing. When clicked the entire menu will open under 
the single line display, above your page content, with all menu links available. 

Trigger Action 

Enable Mouse Over Action 

This option, which is on by default, allows mouse-over activation of the menu triggers. Hovering over a 
menu trigger will open its sub-menu. Moving the mouse away from the trigger will close the sub-menu. 
The click behavior to open or close the sub-menu will still remain enabled to support keyboard and 
mobile device users. 
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Use Trigger Delay 

The PMM3 system includes a built-in action delay to allow for diagonal mouse movements without 
accidentally closing a sub-menu. This feature makes using the menu much easier and should normally be 
left activated. Un-check the box to disable the delay. 

Horizontal Alignment 

These options affect horizontally oriented menus only. 

Menu Alignment 

Horizontal menus can be aligned in one of three ways. Select one of these methods: 

 Left: All root menu items will be left-aligned within the containing page element 

 Centered: All root menu items will be centered within the containing page element 

 Right: All root menu items will be right-aligned within the containing page element 

1st Sub Level Align To 

This controls the alignment of the first level sub-menu relative to its trigger link. The default setting is 
Left Edge of Trigger. 

 Left Edge of Trigger: This will align the left edge of the sub-menu to the left edge of its 

trigger link. 

 Centered: This will center each sub-menu beneath its trigger link. 

 Right Edge of Trigger: This will align the right edge of the sub-menu to the right edge of 

its trigger link. 

Justify 

This option controls the alignment of the first-level sub-menus for the first and last root trigger items in 
a horizontal menu. The first root trigger's sub-menu will always be aligned to the left edge of its trigger. 
If the last root level trigger has a sub-menu, it will be aligned to the right edge of its trigger. This will all 
happen regardless of the 1st Sub Level Align To option chosen. 

  



 

PVII Pop Menu Magic 3 
 

22 Overview 

22 

Image Swap Options 

The system supports using images for links and is designed to automatically handle pre-loading, 
swapping, maintaining states, and assigning a current-marker. This automation requires that you follow 
the image file name convention. The system supports up to 3 different image states. Select the Swap 
Option that you would like to use: 

 Single Image Only - Choose this option if you are using just a single image and do not 

want any swap actions. 

 Normal and Over - Choose this option if you are using two images: one normal image 

and one for the over (hover) state. The over image will also be used for the open (down) 

and current-mark states. 

 Normal, Over and Open Images - Choose this option if you are using three images: one 

normal image, one for the over (hover) state, and one for the open (down) state. The open 

state image will be used for the current-mark state.  

Note: Be sure to choose the option carefully to match the number of image states you are using. The system will 
pre-load the various state images based on this selection. 

Rollover Open State 

This controls the swap action when a trigger link is in its open state. The system will swap to the over 
image if the trigger link is in the open state and you have a 3-state swap option set. Uncheck the box if 
you want to disable this swap action. 

Current Marking 

These settings control the operation of the included automatic Current Marking system. 

Use Current Marking 

This box is checked by default to enable automatic current marking (highlighting) of links in your PMM3 
menu. The system looks for links in the menu that match the current page address. When a matching 
link is found, it's highlighted. 

PMM3 also includes an Advanced Current Marker system to allow you to handle exceptions—so that 
even pages that do not appear as links in the menu can have a specified link Current Marked. 

Include URL Parameters in Match 

This option controls whether the automatic current-marking feature will include any URL parameters in 
the page address when looking for a matching link in the menu. Check this box if you wish to have your 
URL parameters included in the match criteria.  
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Animation Method 

The PMM3 system allows you to choose from 9 animation methods—including None. 

 

Style Theme 

PMM3 comes with pre-defined CSS style themes. Choose a theme that best approximates the look you 
desire. This can act as a starting point from which you can later make edits to the style sheet to fully 
customize your menu(s). You can change to a different style theme at any time without affecting the 
contents of your menus.  

A preview of the selected theme is displayed to the right of the Style Theme select list. This Preview will 
change whenever you select a different theme. 

Rounded Corners 

This option allows you to add rounded corners to the menu structure. The application of rounded 
corners will be based on the Style Theme you have chosen.  

Outer Shadow 

This option allows you to add shadows to the menu. The manner in which the shadows are assigned is 
based on the Style Theme you have chosen.  

Sub-Menu Transparency 

This option allows you to apply transparency to the sub-menus. 
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Command Buttons 

OK 

When you are done setting your desired options, click the OK button to build the menu. The system will 
verify your selections and alert you to any problems that need your attention. If there are no problems, 
the interface will close and a menu will be added to your page or updated—depending on whether you 
are in Create mode or Modify mode. You can then preview in a browser to operate the menu and check 
its functionality.  

Tip: To make further changes, click inside a menu and then open the Pop Menu Magic 3 interface to begin your 
modifications. 

Cancel 

Click the Cancel button to completely abort the current Pop Menu Magic 3 operation. This will close the 
interface and no changes will be made to your page. 

Help 

Click the Help button to open the associated Help File in your browser. This page can remain open for 
easy reference while you continue working with the Pop Menu Magic 3 interface. 

Menu Styling  
Please see the PMM3 Style Guide for CSS tips and information on PMM3. 

  

http://www.projectseven.com/products/menusystems/pmm3/pmm3-style-guide/
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Support and Contact info 
PVII quality does not end with your purchase - it continues with the best customer support in the 
business. 

PVII Communities 

PVII maintains separate and distinct Web Forum and Newsgroup communities. We do this to ensure you 
always have access via your preferred medium and device. 

1. The PVII Web Forums 

The PVII Web Forum is a modern browser-based community, accessible to both desktop and mobile 
devices and requires no additional software or plugins. 

Visit The PVII Web Forum community now... 

2. PVII Newsgroup forums 

The Project VII Newsgroup is available via private and secure NNTP servers. In order to subscribe to a 

newsgroup you must have a newsgroup-capable client installed such as Mozilla Thunderbird or 

Windows Live Mail. 

Server: forums.projectseven.com 

Note: PVII newsgroups are private and have nothing to do with usenet feeds that may be provided by your ISP. That 
is, you will not find our newsgroups in a list of newsgroups distributed by your internet service provider. You must set 
up our news server as a new account. 

Before you Contact us 

Before making a support contact please read the documentation. Include your Dreamweaver version, 
as well as your computer operating system specs in all support correspondence. 

E-Mail: 
support@projectseven.com 

Phones:  
330-650-3675 
336-374-4611 

Phone hours are 9:00am - 5:00pm Eastern Time U.S. 

Snail mail 

Project Seven Development 
339 Cristi Lane  
Dobson, NC 27017 

http://www.pviiforums.com/
mailto:support@projectseven.com
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